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Chapter 1 About WorldChart

WorldChart is a business reporting software that brings innovative 3D graphics and data visualization
technology together to enable you to create more powerful and engaging presentations. Documents,
reports and charts generated using WorldChart are Internet- and Intranet-ready, and display data three
dimensionally for greater visual impact.

WorldChart helps you consolidate information into one clear, fully customizable, Internet-ready report.
With the click of a button, you can transform multiple sets of data into a single, clear format, which
enables you to instantly identify trends and evaluate risks that could effect your business.

WorldChart takes advantage of the best features of the web, to enable you to present the most informa-
tive, and most easily accessed report possible. No other business reporting software or application offers
these advantages today.

Unlike the static charts created from wizards included in Excel, Access, and other products, the charts
created by WorldChart provide a powerful tool for analyzing data more comprehensively and interactively
than is possible with two dimensional pictorial representations. WorldChart also leverages Internet-stan-
dard technologies such as HTML, VRML and Java, which makes it possible to import timely financial
information available on the web and translate it into one cohesive environment.

To use WorldChart, simply:
Import a data file.
Design your report’s look and feel using WorldChart’s Document Wizard, templates and styles
to guide you every step of the way.
Publish the report to your internal or external web site using Microsoft FrontPage.

WorldChart imports files from the most common spreadsheet and database software. By importing files
from other software products, WorldChart extends the use of these products, and brings them to the
Internet. WorldChart can import data from enterprise environment packages such as Microsoft Excel,
Microsoft Access, from comma delimited (text) files from home-use software packages such as Quicken,
and from financial Internet sites such as Microsoft Investor and Quote.com.

Once documents have been generated in WorldChart, they may be exported into standard HTML and
VRML file formats, to be published on the web or viewed on the desktop.
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1.1 System Requirements

Hardware Requirements

• Intel Pentium (or compatible) CPU
• Windows NT or Windows 95
• 16MB RAM
• SVGA graphics accelerator card.

(A graphics accelerator card that supports Direct3D is recommended.)

Software Requirements

• WWW browser, and
• Microsoft FrontPage

Software Included with WorldChart

• Microsoft Internet Explorer 4.01 for Windows 95 and Windows NT, and
• Intervista WorldView 2.1

Viewing published reports requires:

• Intervista WorldView 2.1 or later, or
• Cosmo Player 2.01 or later.

1.2 Setup and Installation

To install from our web site:

• Click on the WorldChart link to begin the installation of WorldChart.

To install from a CD:

• Browse to the directory on the CD-ROM containing the WorldChart software
• double-click on the file ..\WorldChart\disk1\setup.exe to begin installation

Follow the instructions in the InstallShield wizard to complete the installation.

• Download WorldChart into a temporary directory on your hard drive.
• Unzip the file by clicking on the file (WorldChart.exe). This self-extracting archive will create eight

folders in your temporary directory (disk1, disk2, disk3, ...disk8).
• Run the file ../disk1/setup.exe. InstallShield will guide you through the rest of the installation .
• Run the program called WorldChart in the WorldChart program folder.

1.3 About this Manual

This manual and help system has been designed to describe and detail all functions and options avail-
able in WorldChart. To accomplish this, it is designed to follow the sequence of WorldChart’s user inter-
face. First, the major components of WorldChart are defined to act as a basis for the program descrip-
tion. Then, the program itself is described, organized according to the user interface, working from top to
bottom and left to right of the screen. Finally, the processes of importing and exporting files, and the ways
in which WorldChart translates and interprets data are described.

This manual is divided into the following sections:

Getting Started  describes how a simple document may be created, designed, and published using
WorldChart.

WorldChart Components  describes WorldChart’s components, the working aspects of the
WorldChart project or file. This chapter outlines the relations of the basic building blocks of the WorldChart
process: projects, documents, charts, reports, data files, temporary files, and exported files.

Program Overview  describes the working interface for the program: all the buttons, tools, com-
mands, and dialogs, how they work, what they do, and what they can control. This chapter also includes
an abbreviated description of WorldView, the VRML browser used to preview and navigate through the
generated graphs and charts.

Importing Files  describes the means by which a file must be designed for optimum use with
WorldChart, and the various idiosyncrasies and specifics for all file formats supported for import. This
section also includes information on the various types of data files which may be imported to WorldChart,
and how they should be formatted.

Working with Data  describes how WorldChart interprets and translates the data imported to it to
generate its reports and charts. This section also details data mapping and scaling, which are basic tools
or controls for translation to WorldChart format.

Publishing Files  describes how WorldChart files may be published to a directory or FrontPage web.

This manual uses the following typographic conventions:
Bold is used for important terms.
Programmatic items, such as menu items, dialog box names, and button names, are capitalized, as

they appear in the program itself.

Chapter 1  About WorldChart
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1.4 Contacting Intervista

Please feel free to contact us with any questions or suggestions.

Intervista Software, Inc.
181 Fremont Street
San Francisco, CA 94105
Phone: (415) 543-8765
Fax: (415) 278-0550

Intervista Web Site

http://www.intervista.com

WorldChart Product Web Site

For more information about WorldChart, and to see posted examples, tips and tricks, support materials,
frequently asked questions, and case studies, visit:

http://www.intervista.com/worldchart.

WorldView Product Web Site

For more information about the WorldView 2.1 VRML browser, go to:

http://www.intervista.com/worldview.

For information on the WorldView browser, and a more complete description of navigating through gen-
erated charts, see the WorldView User’s Guide at:

http://www.intervista.com/worldview/2-1-docs/user-guide.html.

Intervista Technical Support Web Site

For more information about subscribing to the WorldChart users’ email list server, see our support site at:

http://www.intervista.com/support

or send email to:

worldchart-support@intervista.com.

Intervista Sales Web Site

For sales information for WorldChart or other Intervista products, visit:

 http://www.intervista.com/shop

send email to

moreinfo@intervista.com,

or call our sales line toll-free (US only) at 1-888-766-5433.

WorldChart Product Manager

For information not listed here, or for questions, comments, or problems, please contact Myron Lee
Rosmarin at myron@intervista.com.

Chapter 1  About WorldChart
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Chapter 2  Getting Started

This chapter is an introduction to the working environment of WorldChart, and describes how a simple
document may be created, designed, and published using WorldChart.

Three windows open when WorldChart is launched:

The Main Application Window:  the main editing window in which documents are created.

The Template Gallery:  provides a tabbed interface to all available Document, Report, and Chart tem-
plates. These elements may be double clicked, or dragged and dropped into the main application
window to add them to WorldChart projects.

The Project View Window:  lists all open documents, and all the placed reports and charts contained
within them. This window may be used to select elements, invoke properties editors, and review the
contents of open documents.

Using these three windows as tools, WorldChart provides two ways to create Internet ready documents:

• automatically, with the assistance of the Document Wizard, and
• manually, with the assistance of the templates and property editors.

Both methods are discussed in the sections that follow.

2.1 Using the Document Wizard

The Document Wizard is a tool provided by WorldChart to prompt the user through the creation and
publication of a WorldChart document. This section is provided as a guide to the sequence and use of
the Wizard.

To start the wizard, launch WorldChart, and click on the Document Wizard button (  ) in the main

window’s toolbar.

There are seven steps in the Document Wizard:

1) The first window prompts you to select a document template type and assign a style for the docu-
ment. The document type defines how the published HTML page will be organized. The style will set
the colors and fonts for your document.
• Click on the Two Frame  document template icon to select it.
• From the pulldown menu under Styles, select Fire and Ice .
• Click Next to go to the next window.

2) The second window prompts you to select a chart or report type for each frame in the document. A
window will be invoked for each frame in the selected document type, until an item has been placed
in all available frames. These windows will be presented in order from the top left frame in the
document, to the bottom right frame.
• In the first window presented (Frame 1: the top frame), select Surface chart.
• Click Next .
• In the next window presented (Frame 2: the bottom frame), select General report.
• Click Next .

3) The next window prompts you to select a data source, which will be used for all items in the docu-
ment.
• Click on the Browse button to invoke the Open File dialog.
• Select the file nums.xls  from the C:\Program Files\WorldChart\Example Files directory.
• Click Next .

4) The next window prompts you to select a table to be used from the imported data file. This window
also allows you to select the columns to be imported from this table, and to arrange their order for the
document. All columns from the selected table will be imported by default, arranged in the same
order in which they are listed in the imported file.
• In the Table pull down menu, check that the STOCK$ table is selected.
• Click Next .

Chapter 2  Getting Started
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5) The next window allows you to assign behaviors to data elements based on defined criteria. For
example, to highlight data elements that exceed a given number, you can cause those elements to
spin, pulse, or flash. For this example, we will make any data point in the column titled “Price4,”
whose value is greater than 140, flash.
• Select Price4 from the list of included columns.
• From the pull down menu below, select “>.”
• Type 140 in the input field to the right of this pull down menu.
• From the behaviors pull down menu (to the right of this input field), select Flashing .
• Click Next .

6) The next input window allows you to select your publishing preferences for the generated HTML
documents. You may publish to a Microsoft FrontPage web, to a directory, to both, or to neither. In
this example, we will publish to neither.
• Click Next .

7) The final window presents a summary of your choices, and offers a checkbox to preview the docu-
ment after loading. If checked, the document will be automatically loaded in preview mode. If this box
is left unselected, the document will be opened in thumbnail, working mode.
• Select the Check to Preview Document on Load  checkbox.
• Click Finish to exit the wizard, generate the document and load its preview version into the main
window.

After a few moments (depending on your computer’s performance) the generated page with its 3D
interactive chart appears on your screen. Note that some of the data-points are flashing. These values
are greater than 140, as defined earlier in the Wizard.

(For information on the WorldView browser, and a more complete description of navigating through your
generated chart, see the WorldView User’s Guide, located at http://www.intervista.com/worldview/2-1-
docs/user-guide.html.)

To remove the document from the editing window:
• In the Project View  window, right-mouse click on the item Document1 .
• Select Remove Item  from the popup menu.

2.2 Creating Documents Manually

Creating documents manually is as easy as dragging and dropping the desired objects into place in the
main project window.

1) Launch WorldChart.

2) First, create a document by dragging a document template into the main window from the Document
Template Gallery.
• Select the Documents tab in the Template Gallery window.
• Click on the Two Frame  document, and drag it into the Main Application Window . (You can also
double-click the template to insert it into the application window.)

3) Then, add objects to the document by dragging reports or charts into the document’s frames. (Re-
ports and charts may also be double-clicked to be inserted in the active document frame.)
• Select the Charts tab in the Template Gallery  window.
• Select the Surface chart, and drag it into the top frame of the document.
• Select the Reports tab in the Template Gallery  window.
• Select the General report, and drag it into the bottom frame.

Notice that thumbnail icons appear in the two frames, indicating the type of object that has been placed
in each of these frames.

4) Now, define the document’s properties.

• Click on the Document Properties  button (  )in the main window toolbar:

• Select the Styles and References  tab window.
• In the Document Title  field, type “My Stock Performance .” (The Document Title appears in the
title bar of the web browser.)
• From the Styles pull down menu, select Fire and Ice . This will set the colors and fonts for your
document.
• Select the Publish Properties  tabbed window to define how your document will be published.
From this window, you may select to publish to a FrontPage web, to a directory, to both, or to neither.
• Select the Publish to selected directory  checkbox, and select a directory from the window be-
low.
• Select a drive from the pulldown menu.
• Double click on the listed folders to open them, and select a folder for the published files.
• Click OK to save your changes, and close the dialog.
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5) Next, define the Surface Chart  properties.
• Double click on the Chart icon in the top frame to invoke the Chart Properties  editor.
• Select the Misc tabbed window.
• In the Chart Title  input field, type My Stocks . (The Chart Title appears in the Heads Up Display for
the 3D chart).
• Select the Data tabbed window
• Click on the Browse button next to the Data Source input field to select a data file. Select nums.xls
from the C:\Program Files\WorldChart\Example Files directory.
• Click OK to save your changes, and close the dialog.

6) Finally, define the General Report  properties.
• Double click on the Report icon in the bottom frame to invoke the Report Properties  editor.
• Select the Color and References  tabbed window
• In the Report Title input field, type The Data . (The Report Title appears in the first row, first
column position of the spreadsheet.)
• Select the Data tabbed window
• Click on the Browse button next to the Data Source input field to select a data file. Select nums.xls
from the C:\Program Files\WorldChart\Example Files  directory.
• Click OK to save your changes, and close the dialog.

7) You are now ready to preview the report.

• Click the Preview button (  ) in the main window toolbar.

Depending on the performance of your computer, it will take from a few seconds to a few minutes before
you see the previewed document. Note the icon in the upper-right corner of the main window, which spins
to let you know that it is processing the document.

When it is done processing, the Document Window will contain the generated chart and report.

• The top frame contains the Surface Chart: a 3D visualization of the information contained in the
data file.
• The bottom frame contains the General Report: a spreadsheet of values for stocks and their prices
at various dates.
• The Surface Chart is a VRML world which can easily be navigated. The default navigation mode is
“Walk.” To Walk in the frame, press and hold the left mouse button while dragging it in the top frame.
To move toward the chart, move the mouse up in the window. To move away, drag the mouse down.
To move left or right, drag the mouse in the appropriate direction.
• To select another navigational mode, such as spin, rotate, or pan, select the appropriate tool from
the right mouse pop up menu. Press the right mouse button, and select Movement… from the pop
up menu, then the desired navigational mode.

(For more information on navigating through your charts, and a more complete description of the naviga-
tional modes and the WorldView browser, see the WorldView User’s Guide, located at http://
www.intervista.com/worldview/2-1-docs/user-guide.html.)

Note that as you move your mouse over data-points in the chart, a number is displayed in the lower right
corner of the chart’s frame. The display shows the field name (column heading) and the value for that
data-point.

8) To return to working mode to modify any of the properties, deselect Preview by clicking the Preview
button again.

9) If you are satisfied with your document, you are ready to publish it.
• Click on the Document Properties  button in the main toolbar.
• Select the Styles and References  tabbed window.
• Click on the Browse button next to the Output File  input field to invoke the HTML File Name
window. In the field provided, enter a name for your document. (This file will be published to the
directory selected earlier.)
• Click OK to save your changes, and close the dialogs.

• Click on the Publish button (  ) in the toolbar to publish your document to the selected

directory.

Depending on the performance of your computer, it will take between a few seconds and a few minutes
to complete this operation. Notice the feedback icon in the upper left corner of the main application
window. It will indicate when the document has been published.

Chapter 2  Getting Started
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Chapter 3   WorldChart Components

WorldChart uses several components to design and generate documents. These components are inter-
related, and make up the structure of a WorldChart Project. A description of each of these items is
included here to clarify their position and relationship in the WorldChart working environment.

This section serves as a basic reference for and description of the WorldChart components. More detail
for each of these items is included in the WorldChart Program Overview chapter in the appropriate place.

WorldChart projects are composed of the following components, which may be assembled into Internet
and Intranet ready reports and documents.

• Projects
• Documents
• Charts
• Reports
• Data Files
• Temporary Files
• Published Files

3.1 Projects

Projects are a means to organize your working documents. Projects serve as a container for saved
documents, and opening a Project will open all documents saved to it.

Only one project may be open at a time.

No properties may be set at the Project level, and no limitations are placed on the design of any gener-
ated document by its inclusion in a given project.

WorldChart Project Files (extension: .wpf)

Project files are exported in .wpf format, and contain references to WorldChart Document Files. By
organizing your work with projects, you can simplify the process of opening multiple document files (.wdf
files) at once.

3.2 Documents

Documents are templates from which pages may be made in WorldChart. They serve as containers for
the objects, charts, reports, text, or HTML files which are placed within them.

Some properties may be set at the document level, including the document’s color schemes and text
styles, headers, and footers.

There are four document types available in WorldChart, which differ only in their layout:

One Frame: contains a single frame into which objects (charts or reports) may be placed.

Two Frame: contains two frames, one above the other.

Three Frame: contains three frames, two placed above the third.

Three Frame Inverted: contains three frames, two placed below the third.

WorldChart Document Files (extension: .wdf)

Document files are the basic working files used by WorldChart. These files contain the information used
to build and generate publishable WorldChart documents. They do not contain any data or information
referenced in the imported data files, nor do they encapsulate the generated VRML (.wrl) or HTML (.htm)
files generated by WorldChart for its charts and reports. Document files simply point to the location of
these files.

When documents are saved, to be used while working in WorldChart, they are saved as .wdf files. When
they are published to a web or directory location, they are exported as HTML files with the .htm exten-
sion.

Chapter 3   WorldChart Components
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3.3 Charts

Charts are interactive 3D data visualizations (created in VRML) of the information contained in your
spreadsheets or tables. Charts use data imported in row and column format to generate three dimen-
sional graph objects, which may be inserted into any document frame. Chart properties, such as format,
color, scaling, and applied images, may be individually assigned to customize the appearances of indi-
vidual charts.

WorldChart provides six chart types:

Line Charts

Line Charts arrange information similarly to Bar Charts, but the points of the chart are marked by
cubes. Each row of information is then connected by a line.

Line Charts are most useful for demonstrating trends. The connecting line between data values
shows the relation between one point and the next, and draws an overall picture of the change in the
information over time.

Pie Charts

Pie Charts arrange information as pie slices of the whole. Pie Charts will show information only for a
single item.

Pie Charts illustrate the relation of a percentage or piece of an item to the whole. To generate the pie,
the numeric value of the item is divided by the sum total of all items, then multiplied by 360 degrees.
Pie charts are useful to illustrate a product’s market share, a company’s assets, or the allocation of
money in a budget.

Surface Charts

Surface Charts arrange information similarly to Bar Charts, but connect the points of the grid with a
surface, rather than marking it with columns.

Surface Charts import a two dimensional matrix of values, and plot a three dimensional data land-
scape. This type of chart is most useful when the information to be represented requires analysis in
two directions. examples of such data would be a force applied to a surface, or an analysis of sales
from year to year and state to state.

Bar Charts

Line Charts

Pie Charts

Surface Charts

SingleStock Charts, and

MultiStock Charts

WorldChart Chart Files (extension: .wrl)

Chart files are exported in VRML (.wrl) format. Chart files contain information used to generate the
specific chart objects placed within the HTML document, such as font color and style, data file used,
chart type, and scaling methods.

.wrl files are stored in ASCII format, and the properties defined within them may be edited with any text
editor. Please note that editing .wrl files requires an understanding of the Virtual Reality Modeling Lan-
guage (VRML), as defined in the VRML 2.0 specification.

Bar Charts

Bar charts translate tables of information into 3D objects. They arrange information by plotting one
variable (columns) along one side of a regularized grid, with the other variable (rows) along the other.
Vertical bars are then arranged on the intersections of the grid, with their height determined by the
numeric value of that point.

Bar Charts emphasize individual results, and de-emphasize trends. They are best used to represent
several different types of data for comparative purposes.
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SingleStock Charts

The SingleStock Chart is one of two custom chart types included with WorldChart, and is designed
to chart the performance of an investment such as stock. This chart type uses a predefined configu-
ration of column headings: Date, High, Low, Close, and Volume. These items are mapped to a chart
which is a combination of a bar chart (representing the stock’s volume) placed beneath a line chart
(representing the stock’s closing price).

These charts plot time intervals of a single stock, with the points marked determined by the price and
volume of the stock at that point in time. Price and Volume are plotted against a grid in which the x-
axis represents time (days, weeks, etc.). In the lower half of the chart (Bar Chart), the y-axis is used
to plot volume. In the upper half (Line Chart), it is used to plot the (closing) price of the selected stock.

The combination of bar and line chart is helpful in that the lines may be used to see trends over time,
while the bars may be used to easily visualize trends in the investment’s volume.

For more information on Data Files for SingleStock Charts, see Tables for Single- and MultiStock
Charts.

MultiStock Charts

MultiStock Charts are similar to SingleStock Charts, but plot multiple stocks, and arrange their charts
parallel to one another.

The MultiStock Chart, based on the SingleStock Chart, allows the inclusion of more than one stock.
To achieve this, it imports a multi-table data file, then organizes the chart as a stack of SingleStock
charts, layered along the Z axis. The line chart shown in the upper half of the SingleStock Chart is
then converted to a Surface Chart, which connects the closing price of all visible stocks.

For more information on Data Files for MultiStock Charts, see Tables for Single- and MultiStock
Charts, below.

Chart Structure

WorldChart generates charts by plugging imported information into a predesigned, standard format.
Charts are three dimensional objects, bounded by a cage, framed by a HUD, floating in an infinite space.

Cage:  The two walls and floor which frame the chart and create a visual marker for displayed points on
the generated chart.

Walls:  the vertical planes bounding the chart. Cage walls run the length of the chart, and are set to
a predetermined height. These walls are transparent by default, but may have image maps
applied to their inside surface (the side facing the chart object).

Floor:  the base of the chart, the color of which may be defined in the Chart Properties editor.
Grid:  the gridded pattern on the floor and walls of the cage against which the column and row data

is located. The grid itself is defined by the number of rows and columns in the imported data file.
Cage Steps:  the number of horizontal lines on the cage. The number of cage steps is user-defined,

then scaled against the preset height of the cage itself.
Cage Labels:  the value at each cage step, as shown positioned at the left of the left wall. Cage

Labels are available only when Global Scaling is selected.

HUD (Heads Up Display):  The HUD is a fixed location for text, which appears in front of the chart. The
HUD is essentially a transparent, immobile screen, placed in the near foreground of the space, on which
descriptive text for the chart is shown. The HUD contains several parts:

Chart Title:  displayed in the upper left corner of the frame.
Context Sensitive Information:  displayed in the lower right corner of the screen, changes to reflect

the column name and numeric value of the object over which the cursor is placed. (The cursor
will change to the sensor cursor to indicate that information is available for the selected object.
The text on the HUD will update automatically when the cursor changes.)

Play and Pause buttons:  displayed near the lower left corner of the frame. Only one of these two
buttons is visible at any given time. The cursor changes to the sensor cursor when the button is
selectable.
The Play button appears as a green triangle pointing to the right. Clicking on it will rotate the
chart around the vertical axis.
The Pause button appears as two red vertical stripes. Clicking on it stops the rotation.

PopUp Text:  PopUp Text is a mobile location for text, and includes all text within the space of the chart.
PopUp text includes both text which is always visible within the space of the chart, and text which ap-
pears in response to the proximity of the viewer.

Column Headings:  displayed to the side of each column in the chart, and always visible.
Row Headings:  displayed to the side of each row in the chart, and always visible.
Cage Labels:  displayed at each step in the cage to show the value for that height, and always

visible.
Data Labels:  display the numeric value of an object when the viewer navigates close to that object.

Data Labels appear automatically when the viewer’s proximity to a given object is within a certain
range, and are visible only when indicated by the user’s movement through the space of the
chart.
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Image Files:  WorldChart allows the user to import image files which will be mapped to designated
surfaces in the generated chart.

Cage Left Image:  the image applied to the left side of the box, visible behind the cage step lines.
Cage Right Image:  the image applied to the right side of the box, visible behind the cage step lines.
Background Image:  the image assigned to the background of the space. This image will automati-

cally orient itself perpendicular to the viewer, and will fill the space of the screen. This image will
not move or alter as the user navigates through the WorldChart space.

Sound files:  WorldChart allows you to specify a sound file to be played while the chart is displayed. Two
types of sound are offered, Spatial and Soundtrack, both of which may be WAV (.wav) or MIDI (.mid)
files.

Soundtrack sound emanates uniformly from both speakers, regardless of the position of the user in
the WorldChart space, to create a sense of omnidirectional sound. Soundtrack sound does not
loop, and will play only once.

Spatial sound defines the sound as emanating from the center of the floor grid (world coordinates (0,
0, 0)), and directed primarily toward the viewer, and, to a lesser extent, away from the viewer in
their original position. This directional sound source is then translated to the speakers as the
user moves through the world, orienting the viewer aurally as well as visually. (The position of the
Spatial sound source may not be moved or altered.) This creates a sense of directional sound.
Spatial sound loops continuously while the chart is displayed and the browser window is active.

3.4 Reports

Reports are 2D representations of imported information, which may take one of four formats. They may
be tables generated by WorldChart, which contain tabular representations of the information contained
in imported data files. They may be text or HTML documents, which are placed as is from selected files.
They may also be a combination of these three items.

Report properties, such as font size and color, may be defined for WorldChart generated tables. Text
files imported for WorldChart Text Reports retain their original formatting, but their font color may be
specified. Imported HTML files may not be altered.

WorldChart provides six report types:

General

Analysis

Summary

MultiStock

Text, and

HTML

WorldChart Report Files (extension: .htm)

Report files are exported in HTML (.htm) format. Report files contain information used to generate the
specific report objects placed within the document, such as text font and type, color styles, data mapping
and border sizes.

General Reports

General Reports import the spreadsheet or tabular information contained in the data file, and publish
it in row and column format. General reports replicate the layout of the imported data file, while
adding user defined formatting and color parameters.

Analysis Reports

Analysis Reports combine a General Report and a text-based annotation placed beneath it, in a
single document frame. The Annotation file may be selected from any previously generated text file,
which must be in ASCII (.txt) or HTML (.htm) format.
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Summary Reports

Summary Reports combine a General Report with a text-based annotation placed to the right of the
report. The Annotation file may be selected from any previously generated text file, which must be in
ASCII (.txt) or HTML (.htm) format.

MultiStock Reports

The MultiStock Report is similar to the General Report in that it displays the imported information in
row and column format. It differs from the General Report by offering the additional feature of select-
able links at the top of the frame, which may be used to shift between multiple tables. (The MultiStock
Report is particularly useful when used in conjunction with the MultiStock Chart.)

Text Reports

A Text Report displays an imported text file as it appears in ASCII format. The font color may be set
from within WorldChart.

HTML Reports

An HTML Report displays an imported HTML file as it appears in the original.

3.5 Data Files

Data Files are the files imported to WorldChart from other programs, which contain the numeric and text
information needed to generate charts and reports. Data files may also be text or HTML files which are
placed directly into WorldChart’s document’s frames.

Data may be imported to WorldChart in the following formats:

• Microsoft Excel Files (.xls)
• Microsoft Access Files (.mdb)
• Comma Delimited Text Files (.csv)
• ASCII Text Files (.txt)
• HTML Files (.htm or .html)

Data may be imported to WorldChart using the Properties Editors for charts and reports.

For more information on Data Files, see Importing Data Files, Access Files, Comma Delimited Files, and
Excel Files.

3.6 Temporary Files

Temporary files are created by WorldChart during an editing session to store information for WorldChart
Documents and Objects.

Temporary files are automatically generated by WorldChart when the Preview or Refresh command is
selected from the toolbar, and placed in the Windows/Temp/WorldChart directory. They are saved until
the project or document is saved or published to a directory or web, at which time they are automatically
deleted by WorldChart.

Temporary files should not be used in place of properly generated HTML or VRML files to publish to a
web, as the names of the files may be incorrect.

They are given the default name object type_random number.suffix, which may be changed by the user.
(For example, surface chart_394.wrl, or 1frame_837.htm)

3.7 Published Files

When a WorldChart document is published to a FrontPage web or local directory, it exports all files
required by the document, including the image files, sound files, .html and .wrl files, to the selected
directory or web. Image and sound files are simply copied directly to the web or directory location, in their
original format.

WorldChart files are published in the following formats:

Document files  (.htm) store information which is document specific, such as headers, footers, and
titles, as well as pointers to the objects which are contained within the project.

Chart files  (.wrl) store information which is chart specific, such as the data file used to generate the
chart, the chart type, and the font color and size.

Report files  (.htm) store information which is report specific, such as the data file used to generate the
chart, any annotation files, report type, and font styles.

Each chart and report will generate its own file. Document files do not save or encapsulate the informa-
tion for the objects contained within them, they simply point to the object’s file.
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Chapter 4   WorldChart Program Overview

WorldChart allows users to generate 2D reports and 3D charts, using industry standard data formats
from popular programs such as Microsoft Excel (.xls) and Microsoft Access (.mdb), and then publish
them to a web.

WorldChart is composed of four major window interfaces, which work together to allow the user to
design and publish projects: the Program Window, the Document Window, the Template Gallery, and the
Project View Window.

The Program Window:  contains all active document windows, as well as the main menu bar and toolbar.

The Document Window:  placed within the Program Window, represents a single document, with all its
placed reports or charts. There may be several Document windows open at any time.

The Template Gallery Window:  contains all document, report, and chart templates. Objects may be
added to the project by dragging their icons from this window into the project window.

The Project View Window:  contains an outline of the active project and its open documents, and serves
as a visible control for selecting open documents, charts, and reports. The project’s open documents are
displayed in the Project View window, with their placed objects listed beneath in the order in which they
appear in the document.

Project:  only one project may be open at any time. A project may contain a number of documents.
Document:  any number of documents may be contained within the active project and open at any

time. (The number of open documents may be limited by your computer’s available memory.) A
document may contain chart or report objects in any combination.

Object:  any number of objects may be defined within a given project. An object may be a chart or
report in VRML, HTML, or text format, placed in a document frame.

WorldChart also offers secondary windows, which are used to edit and define the project’s properties.

The Properties Editing Dialogs:  provide a means to edit the properties of documents, charts, and
reports, using a tabbed sequence of dialogs.

Right Mouse Popup Menus:  are available in most of the WorldChart Windows, and are context spe-
cific. Items available from the right mouse menus differ depending on the location of the click, and the
object active when the mouse is clicked.

4.1 The Program Window

The Program window is the main WorldChart window, and contains the title bar, the menu bar, the tool
bar, the status bar, and the main project workspace in which project documents are placed when open.

Title Bar:  composed of the Windows window tool menu, the program name, and the standard Win-
dows collapse, maximize/minimize, and close buttons.

Menu Bar:  lists WorldChart menus, which allow users to define and customize the documents’
properties, and invoke a variety of file management, editing, and publishing commands.

Tool Bar:  contains buttons for standard file management commands, buttons to launch Properties
editors, the Document Wizard, and View commands, and an Intervista icon to the far right which
spins to indicate that an operation is in progress.

Main Project Workspace:  contains all open Documents of the active Project.

Status Bar:  describes the status of the function in progress, and shows the current date and time.

Title Bar

The Title bar is composed of the Windows window tool menu, the Program name (Intervista WorldChart),
and the standard Windows collapse, maximize/minimize, and close buttons.

Menu Bar

The Menu bar contains WorldChart menus, which allow users to define and customize the documents’
properties, and invoke a variety of standard file management and editing commands.

File Menu:  lists all standard file management commands, as well as commands which enable the
user to save project and document settings, and publish documents to web sites or local direc-
tories.

Edit Menu:  lists the standard Cut, Copy and Paste options, which are used to manipulate the con-
tents of the selected frame in the active document.

View Menu:  lists all program interface windows, which may be toggled on or off by selecting the
desired item. A check mark by an item indicates that it is visible.

Window Menu:  lists items used to arrange the project’s open document windows, as well as a list of
all open documents. Selecting a document from the list will make it active, as indicated by a
check mark.

Help Menu:  lists Help and information available for WorldChart and Intervista.
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File Menu

The File menu contains all standard file management com-
mands, as well as commands which enable the user to
save projects’ settings, and publish documents.

This menu is divided into four sections:
Project management , which includes items used to

generate, open, close, and save projects;
Document management , which includes items used

to generate, open, close, and save documents;
Publishing , which allows you to publish documents;

and
Exit , to close the program.

Note: Menu items which include “Document1” update to
reflect the name of the active document. For example, if a
document saved as “Annual Report” is active, the File menu
item will be “Save Annual Report,” rather than “Save Docu-
ment1.”

Save Document1:  saves the active document. If the document has not yet been saved, a dialog is
invoked which prompts the user to designate a file name and location. If the document has been
saved, it is resaved over the previous version, using the original filename.

Save Document1 As…:  saves the active document under a new filename. This generates a new
file, whether or not the document has been previously saved.

Save All:  saves all documents in the current project. If the documents have not yet been saved,
WorldChart prompts the user for a file name for each document. If the documents have been
saved, they will be resaved under their original file names.

Publish Document1:  publishes the active document to the selected web site and/or directory. If the
document has not yet been published, a dialog is invoked which prompts the user to select a
web from the list of available web sites. If the document has been previously published, it will be
re-published to the original web or directory.

If a web site has been selected for any document within a project, all other documents within that project
will publish to the same site by default. Individual documents’ sites may be re-assigned (to differ from
other documents within the project) using the Publish Properties tabbed window, available from the
Document’s Properties editor.

Exit:  closes the program. If there are any documents currently open, invokes a prompt to save
changes before exiting the program.

New Project:  opens a new project. If there is a project currently open, it will prompt the user to save
any changes to it before closing. (There may be only one project open at any time.)

Open Project:  invokes the standard Open dialog, from which a previously saved project may be
opened. (Projects have the file extension .wpf.) If there is a project currently open, it will prompt
the user to save any changes to it before closing. (There may be only one project open at any
time.)

Save Project:  saves the current project.

Close Project:  closes the active project after prompting the user to save any changes.

New…:  invokes a pull down menu, from which a document type may be selected to insert in the
active project. These document types differ only in their layout.

One Frame
Two Frame
Three Frame
Three Frame Inverted

Open Document:  invokes the standard Open dialog, from which a previously saved document may
be selected to insert into the current project. (Saved documents have the file extension .wdf.)

Edit Menu

The Edit menu has the standard Cut, Copy and Paste options, which are
used to manipulate the contents of the selected frame in the active docu-
ment.

Cut:  cuts the selected object, and copies it to the clipboard.

Copy:  copies the selected object to the clipboard.

Paste:  pastes the object contained in the clipboard to the selected frame.

Clear:  clears the active frame (deletes the object within it).
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View Menu

The View menu contains items used to show or hide
program interface windows or elements. A check mark
by an item indicates that it is visible.

The View menu is divided into four sections:
Window items , which allow you to show/hide the

Toolbar and Status Bar;
Program items , which allow you to show/hide the

program windows;
Properties editors , which allow you to show/hide

the properties editors; and
Document control , which includes items used to

preview the document and set general prefer-
ences.

Window Menu

The Window menu offers items used to arrange the open document win-
dows.

Tile Horizontally:  selecting this item tiles all open document win-
dows horizontally: arranges them from left to right in the main
project window.

Note: As with the File menu, items which include “Document1” will update to reflect the name of the
active document. For example, if a document saved as “Annual Report” is active, the View menu item will
be “Refresh Annual Report,” rather than “Refresh Document1.”

Toolbar:  shows or hides the main toolbar, located at the top of the Program window.

Status Bar:  shows or hides the status bar, located at the bottom of the Program window.

Project View:  shows or hides the Project View window.

Templates:  shows or hides the Template Gallery window.

Document Properties:  shows or hides the Document Properties editor.

Chart Properties:  shows or hides the Chart Properties editor.

Report Properties:  shows or hides the Report Properties editor.

Text/HTML Properties:  shows or hides the selected text or HTML report’s Properties list window.

Refresh Document1...:  regenerates the preview for the active document after changes have been
made to any of its properties.

Preferences...:  launches the General Preferences editor, a tabbed interface which includes Chart,
Report, and Publishing Preferences.

View Document1 in default Web browser:  launches the user’s default web browser and loads the
active document. (This item is only available in preview mode.)

Tile Vertically:  selecting this item tiles all open document windows vertically: arranges them from
top to bottom in the main project window.

Cascade:  selecting this item arranges all open document windows such that they are staggered,
stacked atop one another, with their title bars visible.

Arrange Icons:  selecting this item arranges minimized window header bars at the bottom of the
Main Project window.

The second section lists the current project’s open documents by title. Selecting a document from this list
brings it to the fore and makes it active, as indicated by a check mark.

Help Menu

The Help menu lists Help and information files available for
WorldChart.

WorldChart Help Topics: invokes WorldChart Help with
the Contents tab selected.

Contacting Intervista…:  invokes the WorldChart Help
file’s Contacting Intervista page.

Intervista Website:  launches Intervista’s home page in a
web browser on your computer.

WorldChart Website:  launches Intervista’s WorldChart page in a web browser on your computer.

Intervista Support Website:  launches Intervista’s Support page in a web browser on your com-
puter.

About WorldChart...:  invokes the WorldChart info splash screen with current product information
(version, copyright, etc.).
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Chart Properties: invokes the Chart Properties editor for the active chart.

Report Properties: invokes the Report Properties editor for the active report.

Document Properties: invokes the Document Properties editor for the active document.

Document Wizard: invokes the Document Wizard, which may be used to create a WorldChart
document and set its publishing parameters.

Preview: generates a browser preview of the active document.

Refresh: reloads updated files into the browser preview.

Stop: cancels the Preview or Refresh command, and returns the image in the document’s frames to
the thumbnail icon.

Main Project Workspace

The Main Project Workspace serves as the working space for the project, by acting as a container for
Document Windows. All open documents of the active project may be placed in this space. Only one
project may be open at any time.

The Document windows placed in this workspace adhere to common Windows standards, and are
stackable, resizable, selectable, and may be placed and located as desired.

Status Bar

This item may be toggled on and off by selecting it from the View menu, and displays the status of the
current operation, and the current date and time as set on your computer.

Status:  describes the status of the function currently in progress.

Date:  shows the current date, as set on your computer.

Time:  shows the current time, as set on your computer.

The toolbar is shown here in its entirety. (In the working environment, buttons are grayed out unless they
are available for use.)

These buttons are arranged by category:
File menu items: New Project, Open Project, Save, Save All, and Publish;
Edit menu items: Cut, Copy, and Paste;
Properties editors: Chart Properties, Report Properties, and Document Properties;
the Document Wizard button is shown by itself; and
Project View items: Preview, Refresh, and Stop.

The Intervista icon to the far right of the tool bar rotates to indicate that an operation is in progress.

The Tool Bar may be toggled on and off by selecting it from the View menu.

New Project: opens a new project. If a project is currently open, invokes a prompt to save the
current project and its associated documents.

Open Project: invokes the standard Open dialog, from which a previously saved project may be
opened. If a project is currently open, invokes a prompt to save the current project and its asso-
ciated documents.

Save: saves the active document and the current project, and invokes the standard Save As dialog
if the document or project has not yet been saved.

Save All: saves all open documents and the current project.

Publish: publishes the active document to a FrontPage web or local directory, as set in the Publish
Properties tab of the Document Properties editor or General Preferences editor.

Cut: cuts the object from the active frame, and copies it to the clipboard.

Copy: copies the selected object into the clipboard.

Paste: pastes the object from the pasteboard into the selected frame.

Tool Bar

The Tool Bar contains buttons for the standard file management commands, as well as buttons to launch
the Chart, Report, and Document Properties dialogs and the Document Wizard, and to Preview and
Refresh working documents.
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4.2 The Document Window

Document windows, which are placed in the Project Workspace, each contain one document, or page, of
the active project. Several Documents may be placed and visible at any time. All open documents of the
active project may be placed in this space. Only documents from the active project may be open.

This window consists of:

• Title bar:  contains the document’s title; the collapse, min/max, and close buttons; and the stan-
dard Windows menu icon.

• Document title bar:  contains the document’s title. Double clicking in this space invokes the Docu-
ment Properties editor for the selected Document.

• Frames:  Into which charts and reports are placed, the number of which is dependent on the type
of document selected.

Right Mouse clicking in a frame of a document will invoke a menu, from which properties may be set,
reports and charts may be added or removed from the document, or information about the active object
may be obtained.

When in Preview mode, all of the standard WorldView browser navigational functions and quick keys are
available. For more information on navigating in Preview mode, see Navigating within the Document’s
frames. (It is important to note that, by default, WorldChart hides the WorldView navigation bar in preview
mode. To make this toolbar available, select the WorldView right mouse menu option Show Navigation
Bar. For more information and a more complete description of these functions and the WorldView browser,
see the WorldView User’s Guide, located at http://www.intervista.com/worldview/2-1-docs/user-guide.html.)

Navigating Within the Document’s Frames

It is important to note that, by default, WorldChart hides the WorldView navigation bar in preview mode.
To make this toolbar available, select the WorldView right mouse menu option Show Navigation Bar.

In preview mode, all standard WorldView quick keys and functions are available in the document win-
dow. The WorldView right mouse menu is also available to set options and preferences, and invoke
WorldView specific Help. (For more information and a more complete description of these functions and
the WorldView browser, see the WorldView User’s Guide, located at http://www.intervista.com/worldview/
2-1-docs/user-guide.html.)

The left, vertical toolbar contains tools used to navigate through the world using the mouse as a control.
These navigational modes are also available through the right mouse menu, and through quick key
commands (described below).

Use Walk to move forward and backward along a single horizontal plane. To move for-
ward, click the mouse button and drag straight up, toward the top of the screen. To move
backward, click and drag straight down, toward the bottom of the screen. Clicking and
dragging at an angle will move you along a corresponding diagonal within the horizontal
plane.

Use Pan to move up, down, left, or right within a single vertical plane. Drag straight up to
move upward, drag to the left to move left, and drag along an angle to move diagonally.

You will move in the direction in which you drag the mouse, therefore the world will appear
to move in the opposite direction.

Use Turn to change the angle of your view. You can turn up, down, or to the left or right.
Dragging in any direction will cause you to turn in that direction. To turn right, drag the
mouse directly to the right. To turn downward, drag the mouse directly downward. As with
Pan, you move in the same direction as the mouse, so the world appears to move in the
opposite direction.

Use Roll to rotate clockwise or counter-clockwise within a single vertical plane. Drag the
mouse to the right to rotate clockwise; drag to the left to rotate counter-clockwise. Unlike
other types of navigation, vertical movement of the mouse has no effect with Roll.

Goto and Study are designed to help you examine individual objects within a scene.

Use Goto to pick an object in a scene to move toward. When you select the Goto icon in
the toolbar, the cursor will change to a crosshair. Click on an object in the world and you’ll
move directly to it.

Goto will always center the selected object in the screen. However, it is not always appar-
ent how large an object is; therefore, Goto may have unpredictable results.
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Use Study to examine an object in the round. Select the Study tool, then click on the
object you’d like to examine. Drag the mouse to move around the object: drag left to see
the left side of the object; drag upward to see the top of it, etc. The view moves in the
direction of the mouse around the selected object.

4.3 The Template Gallery Window

The Template Gallery Window contains all available document, report, and chart types, arranged in
tabbed windows. Dragging items from these windows into the main window or a document’s frame
generates new documents or adds reports and charts to an existing document.

Items in this window may also be added to the project by double clicking on them. Double clicking on a
document will place it in the Project Window and make it active. Double clicking on a chart or report will
insert it into the active document frame.

This window may be toggled on and off by selecting it from the View menu.

The following Template Gallery tabs are available:

• Documents tab window:  Contains an iconic list of the available document types.

• Reports tab window:  Contains an iconic list of the available report types.

• Charts tab window:  Contains an iconic list of the available chart types.

Documents Tab Window

The Documents tab window, available from the Template Gallery window, contains an iconic list of the
available document types. These icons may be dragged from this window to the main project window to
add a page of the desired document type to the active project.

Once a document has been added to the project, it may be edited and its properties changed using the
Document Properties editor, available by double clicking in the Document’s title, selecting Document
Properties from the View menu, or clicking the Document Properties button in the toolbar.

Additional information on generating and editing documents may be found in the following sections:

Document Types  describes the types of documents available to WorldChart.

Document Properties Editor  describes the editor, which provides a tabbed interface through which
document properties may be defined and edited.

Document Wizard  describes the Document Wizard, which guides the user through a step-by-step
sequence to create a document.

Remember that the object you’re studying isn’t moving, you are, and your view of the world will change
accordingly.

In the lower, vertical toolbar, WorldView provides three tools that can help you move around a world, and
re-orient you if you’ve navigated your way into an unusual position. Unlike the navigation tools, these
buttons invoke automatic actions that take place as soon as you click on them.

Use Zoom Out to automatically get a distant view of the entire world. You’ll move away
from the world until it can be seen on your screen in its entirety.

Use Straighten Up to reposition yourself so that your view of the world is upright.

Use Restore to automatically return to the loaded world’s original Viewpoint.

The navigation quick keys are also available.

To change navigation modes:

Walk: Ctrl+Shift+W
Pan: Ctrl+Shift+P
Turn: Ctrl+Shift+T
Roll: Ctrl+Shift+R
Goto: Ctrl+Shift+G
Study: Ctrl+Shift+S

To navigate using the arrow keys:

Drag left: Left arrow
Drag right: Right arrow
Drag up: Up arrow
Drag down: Down arrow

To perform preset view changes:

Zoom Out: Ctrl+Shift+Z
Straighten Up: Ctrl+Shift+U
Restore: Ctrl+Shift+E
Next Viewpoint: Page Down
Previous Viewpoint: Page Up

For more complete information on navigating in WorldView, see the WorldView User’s Guide, located at
http://www.intervista.com/worldview/2-1-docs/user-guide.html, and also available from the right mouse
popup menu while in Preview mode in WorldChart.
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Document Types

Documents are templates from which pages may be made in WorldChart. They serve as containers for
the charts, reports, text, or HTML files, which are placed within them.

Document types differ only in their layout.

There are four document types available in WorldChart:

One Frame:  contains a single frame into which objects (charts or reports) may be placed.
Two Frame:  contains two frames, one above the other.
Three Frame:  contains three frames, two placed above the third.
Three Frame Inverted:  contains three frames, two placed below the third.

Dragging a document into the project window places it and makes it active. The mouse must be dropped
on working space. If it is dropped anywhere else, no error message will be posted, but nothing will
happen, and nothing will be placed.

Documents cannot be dragged into other documents.

Some properties may be set at the document level, including the document’s color scheme, headers,
and footers.

Reports Tab Window

The Reports tab window, available from the Template Gallery window, contains an iconic list of the
available report types. These icons may be dragged from this window into a frame of any placed docu-
ment in the main project window to add the selected report to the active document. Double clicking on a
report icon will also add it to the selected frame of the active document.

Once a report has been added to the project, it may be edited and its properties changed using the
Report Properties editor, available by double clicking on the placed report thumbnail, selecting Report
Properties from the View menu, or clicking the Report Properties button in the toolbar.

Additional information on importing, generating, and editing reports may be found in the following sec-
tions:

Report Types  describes the types of reports available in WorldChart.

Report Properties Editor describes the Report editor, which provides a tabbed interface through
which report properties may be defined and edited.

HTML Report Editor  describes the HTML Report editor, which may be used to select an HTML file
for a report.

Text Report Editor  describes the Text Report editor, through which Text Report properties may be
defined and edited.
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Report Types

Reports are 2D representations of imported information, which may take one of four formats. They may
be tables generated by WorldChart, which contain 2D text representations of the information contained
in imported documents. They may also be text or HTML documents, or a combination of these three
items.

The Reports Tab window contains an iconic view of the available reports. These may be added to docu-
ments by dragging them from this window into the desired frame, or by double clicking on a report icon to
place it in the active document frame.

General:  imports the spreadsheet information from a Microsoft Excel .xls files, Microsoft Access
.mdb files, or comma delimited .csv files, and publishes it in row and column format. General
reports essentially replicate the layout of the original data file in the WorldChart document.

Analysis:  combines a General report with a text-based annotation placed beneath it, in a single
document frame. The Annotation file may be selected from any previously generated text file,
which must be ASCII text (.txt) or HTML (.htm).

Summary:  combines a General report with a text-based annotation placed to the right of the report.
The Annotation file may be selected from any previously generated text file, which must be
ASCII text (.txt) or HTML (.htm).

MultiStock:  displays imported information in row and column format. It features selectable tabs at
the top of the frame, which may be used to shift between the imported reports.

Text:  displays an imported text file as it appears in ASCII format.

HTML:  displays an imported HTML file as it appears in the original.

Reports must be placed into a document. They may not be placed in a project as autonomous objects.

Reports also require an imported data file, in table, text, or HTML format. For more information on
designing and importing data files, see Importing Data Files.

Analysis and Summary Reports may be annotated, in that a text or HTML description may be placed next
to the chart by selecting the appropriate file for the Annotation Source property in the Report Property
editor. This option is available only for the Analysis and Summary type Reports, as indicated by their
thumbnail icons.

For more information on the various reports and their uses, see Reports.

Charts Tab Window

The Charts tab window, available from the Template Gallery window, contains an iconic list of the avail-
able chart types. These icons may be dragged from this window into a frame of any placed document in
the main project window to add the selected chart to the active document. Double clicking on a chart icon
will also add it to the selected frame of the active document.

Once a chart has been added to the project, it may be edited and its properties changed using the Chart
Properties editor, available by double clicking on the selected chart or by pressing the Chart Properties
button in the toolbar.

Additional information on importing, generating, and editing reports may be found in the following sec-
tions:

Chart Types  describes the types of charts available in WorldChart.

Chart Properties Editor  describes the editor, which provides a tabbed interface through which chart
properties may be defined and edited.
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Chart Types

Charts are interactive 3D data visualizations (created in VRML) of the information contained in spread-
sheets or tables. Charts use imported 2D text or table information to generate three dimensional graph
objects, which may be inserted into any document frame. Chart properties, such as format, color, scal-
ing, and applied images, may be defined to customize the appearance and impact of individual charts.

The Charts Tab window contains an iconic view of the available chart types. These may be added to
documents by dragging them from this window into the desired frame, or by double clicking on a report
icon to place it into the active document frame.

Bar Chart:  arranges information by plotting tow sets of variables along two sides of a regularized
grid. For instance, cities might be plotted against the months of the year.

Columns are then arranged on the intersections of the grid, with their height determined by the
numeric value of that point. For instance, the number of inches of rainfall in that city in that month
would be indicated by the column height.

Line Chart:  arranges information similarly to the Bar Chart, but the values plotted on the grid are
marked by cubes, which are connected by a line which follows the information being tracked.

Pie Chart:  arranges information as pie slices of a whole. Pie Charts show information only for a
single item.

Surface Chart:  arranges information similarly to the Bar Chart, but the values plotted on the grid are
connected with a surface, rather than marked by columns.

SingleStock Chart:  plots time intervals against a single stock, with the points marked determined
by the price or volume of the stock at that point in time. These items are mapped to a chart which
is a combination of a bar chart (representing the stock’s volume) and a line chart (representing
the stock’s closing price). This chart type uses a user-editable, pre-defined configuration of
Date, High, Low, Close and Volume.

MultiStock Chart:  similar to the SingleStock Chart, but plots multiple stocks, and arranges them
parallel to one another. The Line Charts representing the stocks’ closing prices are connected to
one another by a Surface Chart.

Charts must be placed into a document, and may not be placed in a project as autonomous objects.

The user should choose the chart type wisely, as one chart type may be more suited to the information to
be shown than another.

Charts require an imported data file in table format. For more information on designing and importing
data files, see Importing Data Files.

For more information on the various charts and their uses, see Charts.

4.4 The Project View Window

The Project View Window, which is automatically opened when WorldChart is launched, contains a list of
all open documents within the active project. All objects contained within each document, charts, reports,
text and HTML files, are listed beneath the appropriate document.

Selecting an item in the list brings the appropriate document to the foreground in the Project Window.

This list behaves like an indexed outline: clicking a plus/minus sign beside a document in the list, or
double clicking the document icon or name itself, opens/closes the selected document’s list of objects.
Double clicking a document, chart, or report name also invokes the Properties editor for the object, and
brings the document in which the object is placed to the top of the stack. Double clicking on an object
selects the object in the project view window, and brings the document window to the top of the stack.

This window may be toggled on and off by selecting it from the View menu.

For more information on Projects, Documents, and Objects, see World Chart Components.

4.5 Right Mouse Popup Menus

Right Mouse popup menus are available almost everywhere in WorldChart. These menus contain a
standard set of commands, which differ according to the active object and the location of the mouse at
the time of click.

In Preview mode for charts, the right mouse popup menu available from the Document Window is the
standard WorldView pop up menu. (For more information on WorldView, see the WorldView User’s
Guide, located at http://www.intervista.com/worldview/2-1-docs/user-guide.html.)

Items available from the right mouse menus include:

View Document Properties:  invokes the Document Properties editor for the active document.

View Object Properties:  invokes the Object Properties editor for the selected object. The title of this
command will change to reflect the active object (Document, Report, or Chart).

Add Report…:  invokes a pop up menu, from which the desired report type may be selected to be
added to the active frame. All WorldChart report types are available from this menu.

Add Chart…:  invokes a pop up menu, from which the desired chart type may be selected to be
added to the active frame. All WorldChart chart types are available from this menu.

Remove Item in Frame:  deletes the selected object from the active frame.

What is this object?:  invokes pop up Help for the selected object. This item updates to reflect the
active object in the project, and will link to Help on documents, reports, charts, text files, and HTML files.
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Styles and References

The Styles and References  page
contains items used to define the
document’s title, and color scheme.

Document Title: the selected
document’s title, which is displayed in
the browser’s title bar. This title may
be changed by simply typing in the in-
put field. Changing the Title also up-
dates the Title bar and the Header bar
for the selected document and its
thumbnail.

Output File: the selected document’s output file, which is used to save the parameters for the generated
page. Documents are saved as .wdf files. Clicking on the Browse button invokes the standard Windows
Save As dialog, with which the document file may be exported. (The temporary file name is entered
automatically in this field, but may be changed by the user.)

Styles: the selected document style. Selecting an item from the pull down menu list will apply a pre-
defined color and font scheme to the document, immediately overriding any color and font settings pre-
viously assigned. Available styles include None, GenPrefs, WorldChart, Teal, Steel, Rose, Brown, Blue,
and Fire and Ice.

None indicates that no style is active, and colors and font styles may be set using the properties editors.

GenPrefs is the style defined by the current settings in the General Preferences editor. Any changes
made in this editor will immediately update the GenPrefs style.

WorldChart is the default style shipped with the product.

Selecting a style from the Styles pulldown menu applies the style to the active document, updates the
text to the right of the menu to indicate that the selected style has been applied, and immediately reverts
the selected menu item to <None> to indicate that colors and fonts may be applied individually in the
properties editors.

Note: Selecting a style from this menu will immediately override all previously assigned colors and fonts
in the active document.

Document Color: the selected document’s color, as shown in the preview window, which is used for the
background of any chart or report placed within the document. Clicking on the browse button invokes the
standard Windows Color dialog, from which the desired color may be selected.

4.6 Properties Editing Dialogs

Double clicking on an object will launch the appropriate properties editing dialog for the selected object.
They may also be accessed using the toolbar buttons or the right mouse menu items. This is a tabbed
interface, in which the user may set the desired properties for the object.

There are a variety of dialogs used to define WorldChart properties, each of which contains tabs specific
to the selected object.

• Document Properties Editor
• Chart Properties Editor
• Report Properties Editor
• General Preferences Editor

Each of these editors contain:
• a Cancel button, which cancels any input in the dialog and closes the window;
• an Apply button, which applies any input and closes the window;
• an OK button, which inputs the changes and closes the dialog; and
• a Help button, which invokes WorldChart Help.

(Using the Close button in the top right of the Header bar closes the window without applying any changes.)

(The Apply button is not available for the General Preferences editor.)

Any changes made through the properties editors are shown immediately in thumbnail view, and in
preview mode after selecting Refresh, or reselecting Preview. Entering invalid properties is not permit-
ted, and will invoke a warning dialog.

Document Properties Editor

The Document Properties editor provides a tabbed interface from which Document properties may be
defined and edited. This editor may be invoked by clicking on the Document Properties button in the
main window toolbar, by double clicking on the document’s title bar in the Document Window, or by
selecting Document Properties from the View menu.

Document settings are organized into three tabbed panels: Styles and References, Header and Footer,
and Publish Properties. Each tabbed window groups properties by type for easy reference.

• The Styles and References  page contains items used to select a document style, and name the
document and its output file.

• The Header and Footer  page allows you to select a Header and Footer file.

• The Publish Properties  page includes items used to determine how the document will be pub-
lished when Publish is selected from the toolbar or File menu.
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Publish to FrontPage web?: selecting this check box will publish the document to the selected FrontPage
web when the Publish command is executed.

Available webs on selected server: the webs available on the selected FrontPage server.

Enter a server: the URL of the selected FrontPage web. Clicking on the Refresh button will allow you to
browse through the available webs.

Publish to file?: selecting this check box will publish the document to the selected directory when the
Publish command is executed.

Select drive: standard Windows format pull down menu from which the desired drive may be selected.

Select folder: field in which the selected directory is listed.

Publish location directory: displays the selected folder’s directory path. This folder will be the publish
location for the document when it is published to file.

Publish Properties

The Publish Properties  page in-
cludes items used to determine how
the document will be handled when
Publish is selected from the toolbar or
File menu. The Document Publish
Properties are specific to each docu-
ment, and will be applied each time
the document is published.

Documents may be published either
to a FrontPage web, or to a directory,
or to both simultaneously.

Header and Footer

The Header and Footer  page in-
cludes input fields for the document’s
Header, and Footer Files.

Header File: the selected document’s
header file, which is displayed at the
top of the generated page. Clicking on
the Browse button invokes the stan-
dard Windows Open dialog, from
which the desired file may be selected.
Allowable file types, as designated in
the file type pull down menu, are text
Files (*.txt), HTML Files (*.htm),
Bitmap Files (.bmp), JPG Files (*.jpg),
and GIF Files (*.gif).

Footer File: the selected document’s footer file, which is displayed at the bottom of the generated page.
Clicking on the Browse button invokes the standard Windows Open dialog, from which the desired file
may be selected. Allowable file types, as designated in the file type pull down menu, are text Files (*.txt),
HTML Files (*.htm), JPG Files (*.jpg), and GIF Files (*.gif).
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Y Factor: the scaling factor applied to the chart along the Y axis, as selected from the slider bar. Valid
input ranges from 1 to 100. (The width of a bar in a bar chart is set equal to “one” for this scale.)

Z Factor:  the scaling factor applied to the chart along the Z axis, as selected from the slider bar. Valid
input ranges from 1 to 100. (The width of a bar in a bar chart is set equal to “one” for this scale.)

Cage Steps: the number of horizontal lines to be shown on the enclosing walls of the generated chart, as
selected from the slider bar or entered in the input field. Valid input ranges from 3 to 10.

Chart Title: the Title for the chart, which will appear in the upper left corner of the HUD of the generated
object, as well as in the document’s thumbnail icon for the placed chart. This field may be edited by
simply typing within it. (Note: As part of the HUD, the font properties and color are set using the HUD text
properties under the Color and Font tabbed window.)

Scaling Type: the scaling type used for the graph. The pull down menu lists available types: Global,
Column, and Row. (For more information on Scaling Type and its options, see Chart Scaling.)

Chart Type: the chart’s type, as selected from the pull down menu. Available types include Bar, Line, Pie,
Surface, SingleStock, and MultiStock. Changes to the chart type will be immediately reflected in the chart
‘s thumbnail in the document window after selecting the OK or Apply button.

Sound Source: the WAV (.wav) or MIDI (.mid) file associated with the chart. Clicking on the Browse
button invokes the standard Windows Open button, from which the desired sound file may be selected.

Sound Type: the sound type, Soundtrack or Spatial, that will be applied to the sound file in the generated
chart, as selected from the pulldown menu.

Soundtrack generates sound which is not influenced by the position or movement of the viewer.
Soundtrack sound will play only once.

Spatial generates directional sound, which is placed at the world origin (0, 0, 0), and responds to the
position and movement of the viewer. Spatial sound loops continuously.

View Distance: the distance from the chart at which the initial viewpoint will be set, as selected from the
pulldown menu. Distance may be set to Near, MidRange, or Far.

View Angle: the view angle at which the initial viewpoint will be set, as selected from the pulldown menu.
View Angle may be set to Top Down, Level, or Low.

Decimal Precision: the decimal point position to which numeric input will be entered from the data file
for the generated chart. (For example, 1.07 has a decimal precision of 2, and .007 has a decimal preci-
sion of 3.) Decimal Precision may be set from 0 to 5 using the slider bar or the input field.

Chart Properties Editor

The Chart Properties editor provides a tabbed interface for setting chart properties, and may be invoked
by double clicking on the placed chart, selecting Chart Properties from the View menu or Show Proper-
ties for Chart from the right mouse menu, or by clicking on the Chart Properties button in the main
window toolbar.

Each tabbed window groups properties by type for easy reference.

• The Misc page includes items used to define the final appearance of the generated chart: scaling
factors, sound sources, image text, viewing parameters, and other view related items.

• The Color and Font  page includes items used to define font and color scheme parameters for the
generated chart.

• The Data page includes items used to select the imported data file, and arrange its components.

• The Behavior page is used to assign animations to chart values, based on user-defined criteria.

• The Images page is used to select and assign texture mapped images for the generated chart.

(For more information on the configuration of charts, see Chart Structure.)

(All charts require a source file. For more information on designing and importing data files, see Import-
ing Data Files.)

Misc

The Misc page includes items used
to define the final appearance of the
generated chart: scaling factors,
sound sources, text, viewing param-
eters, and other environmental items.

X Factor: the scaling factor applied
to the chart along the X axis, as se-
lected from the slider bar. Valid input
ranges from 1 to 100. (The width of a
bar in a bar chart is set equal to “one”
for this scale.)
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Data

The Data page includes items used
to select the imported data file, and
arrange its components.

Table Name:  The name of the
table used from the data source, as
selected from the pull down menu.

Data Source:  The data source file
used to generate the chart. Clicking
on the Browse button invokes the stan-
dard Open dialog, from which the de-
sired file may be selected.

Imported Fields:  The list of imported Column Names, used to organize columns from the imported data
file for the chart to be generated. The X in the left-hand column must be clicked on and highlighted to
perform an operation on the corresponding item. X indicates that the column will be included; 0 indicates
that it will not be included in the generated chart.

Move Up:  moves the selected item one up in the list.
Move Down:  moves the selected item one down in the list.
Add:  marks the column to be imported to the chart, as indicated by an “X” to the left of the column

name.
Remove:  marks the column to be excluded from the chart, as indicated by an “O” to the left of the

column name.

(For more information on designing and importing data files, see Importing Data Files.)

Color and Font

The Color and Font  page includes
items used to define font and color
parameters for the generated chart.

Select Popup Font: font parameters
for popup text. Clicking on the button
invokes the Font dialog from which the
font, style, and size may be selected,
and a sample previewed.

Select HUD Font: font parameters for
HUD text. Clicking on the button in-
vokes the Font dialog from which the
font, style, and size may be selected,
and a sample previewed.

Popup Text Justify: the justification for the popup text, as selected from the popup menu. Text may be
Default, Left, Right, or Center justified. The Default setting will automatically justify the text according to
its position on the chart: text on the left side will be right justified, and text on the right side will be left
justified. This option generates the best results, and should be used whenever possible.

HUD Text Justify: the justification for the HUD text, as selected from the popup menu. Text may be
Default Left, Right, or Center justified. The Default setting will automatically justify the text according to
its position on the HUD: text on the left side will be left justified, and text on the right side will be right
justified. This option generates the best results, and should be used whenever possible.

Popup and HUD Text Color: the color used for the Popup/HUD text. Clicking on the browse button
invokes the standard Windows Color dialog, from which the desired color may be selected.

Start Color: the start color, located at the first entry or lowest point in the chart, used for the graph color
gradient. Clicking on the browse button invokes the standard Windows Color dialog, from which the
desired color may be selected.

End Color: the end color, located at the last entry or highest point in the chart, used for the graph color
gradient. Clicking on the browse button invokes the standard Windows Color dialog, from which the
desired color may be selected.

Grid Color: the color used for the grid on the floor and walls of the generated chart. Clicking on the
browse button invokes the standard Windows Color dialog, from which the desired color may be se-
lected.

Floor Color: the color used for the floor in the generated chart. Clicking on the browse button invokes
the standard Windows Color dialog, from which the desired color may be selected.
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Images

The Images page is used to select
and assign mapped images for the
generated chart. (Images may not be
applied to the cage for Single- or
MultiStock Charts.)

Cage Right Image: the texture
mapped image applied to the right
cage wall of the generated chart. Click-
ing on the Browse button invokes the
standard Windows Open dialog, from
which the desired image file (.gif, .jpg,
or .png) may be selected. This image
is displayed in the preview window to
the right.

Cage Left Image: the texture mapped image applied to the left cage wall of the generated chart. Clicking
on the Browse button invokes the standard Windows Open dialog, from which the desired image file (.gif,
.jpg, or .png) may be selected. This image is displayed in the preview window to the right.

Background Image: the image file used for the background of the generated chart. Clicking on the
Browse button invokes the standard Windows Open dialog, from which the desired image file (.gif, .jpg,
or .png) may be selected. This image is displayed in the preview window to the right.

Behavior

The Behavior page is used to assign
animations to chart values.

This page acts as a sentence defini-
tion of animations to be applied for
given numeric values in the chart. It is
organized to read: For each “column
name” in “file name” where the value
is greater than (>), less than (<), equal
to (=), greater than or equal to (=>),
less than or equal to (<=), or not equal
to (<>) the entered number, make the
object in the generated chart spin,
pulse, or flash.

You fill in the blanks. Using the pulldown menu, select a column from the table listed to the right. Then,
select less than, equal to, or greater than from the pulldown menu below, and type a number in the field
to its right to define which values in the generated chart will be affected. Finally, select an animation from
the pulldown menu to the right, which includes Spinning, Pulsing, and Flashing.

Only one behavior may be assigned per chart, but it may be applied to any number of selected columns.
Behaviors will not be applied to text, or to columns containing text.
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Color and References

Color and References  are used to
design color schemes and report type
and title used for the generated report.

Heading Color: the color of the
heading’s background, as selected
from the standard Windows Color dia-
log, invoked by clicking on the browse
button. (The Report Heading is made
up of the column names, and is lo-
cated at the top of the report.)

Heading Font Color: the color of the Heading Font, as selected from the standard Windows Color
dialog, invoked by clicking on the browse button. (The Report Heading is made up of the column names,
and is located at the top of the report.)

Field Color: the color used for the report’s fields’ background, as selected from the standard Windows
Color dialog, invoked by clicking on the browse button.

Field Font Color: the color of text in the report’s fields, as selected from the standard Windows Color
dialog, invoked by clicking on the browse button.

Report Title: the title of the report. Clicking in this field activates the input field above, in which the
desired title for the report may be typed. The Report title appears above the column names in the gener-
ated report, and below the table tabs in MultiStock reports.

Note: The Report Title font properties and color are set using the Heading text properties for the report.

Report Type: the report type, as selected from the pulldown menu. Available types include Analysis,
General, Summary, and MultiStock.

Annotation Source: the text (.txt) or HTML (.htm) file used to annotate the report. Clicking in this field
invokes the standard Open dialog, from which the desired file may be selected. The annotation will
appear in the document frame beneath (Analysis) or to the right of (Summary) the report.

Report Properties Editor

The Report Properties editor provides a tabbed interface from which Report properties may be defined
and edited. This editor may be invoked by double clicking on the selected report, selecting Report Prop-
erties from the View menu or Show Properties for Report from the right mouse menu, or by clicking on
the Report Properties button in the toolbar.

Each tabbed window groups properties by type for easy reference.

• Color and References  are used to design and define color schemes and report type and title used
for the generated report.

• Font properties  are used to define the text to be used in the generated report.

• Data properties  are used to select the desired table to be used from the selected file, and to select
and arrange the table’s columns to be used in the generated report.

(For more information on designing and importing data files, see Importing Data Files.)
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Data

Data Properties  are used to select the
table to be used from the imported
data file, and to select and arrange the
table’s columns to be used in the gen-
erated report.

Table Name:  The name of table used
from the data source, as selected from
the pull down menu.

Data Source:  The data source file
used to generate the report. Clicking
on the Browse button invokes the stan-
dard Open dialog, from which the de-
sired file may be selected.

Imported Fields:  The list of imported Column Names, used to organize columns from the imported data
file for the report to be generated. The X in the left-hand column must be clicked on and highlighted to
perform an operation on the corresponding item. X indicates that the column will be included; 0 indicates
that it will not be included in the generated report.

Move Up:  moves the selected item one up in the list.
Move Down:  moves the selected item one down in the list.
Add:  marks the column to be imported to the chart, as indicated by an “X” to the left of the column

name.
Remove:  marks the column to be excluded from the chart, as indicated by an “O” to the left of the

column name.

(For more information on designing and importing data files, see Importing Data Files.)

Font

Font properties are used to define the
text style to be used in the generated
report.

Heading Font Type: the type of font
used for the heading, as selected from
the pull down menu. Available font
types include Plain, Serif, Sans and
Typewriter. (The Report Heading is
made up of the column names, and is
located at the top of the report.)

Heading Font Style: the style of the heading font, as selected from the pull down menu. Available styles
include Default, Bold, Italic, and BoldItalic.

Heading Font Size: the size of the font used for the heading (4-8), as selected from the slider bar or
entered in the input field. Invalid input will not be accepted.

Field Font Type: the type of font used for the fields, as selected from the pull down menu. Available
types include Plain, Serif, Sans and Typewriter.

Field Font Style: the style of text in the report’s fields, as selected from the pull down menu. Available
types include Default, Bold, Italic, and BoldItalic.

Field Font Size: the size of the text (1-4) used in the fields, as selected from the slider bar or entered in
the input field. Invalid input will not be accepted.

Table Border Size: the size of the borders used for the report table (0-6), as selected from the slider bar
or entered in the input field. Invalid input will not be accepted.
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Text Report Editor

The Text Report Object Properties list window lists the prop-
erties currently assigned to the selected report, and pro-
vides an interface used to edit them.

This window may be invoked by double clicking on the
placed report, selecting Show Properties for Text from the
right mouse menu, or HTML/Text Properties from the View
menu.

Text objects may not be altered in WorldChart: they are simply placed as is, and retain all preset proper-
ties. The Text Report Object Properties list window may be used to select the text file itself, to locate it
within the document’s frame, and to assign a color to the font.

Object Type: the selected object’s type: Text.

Data Type: the data type for the report: Text.

Data File: the placed text file. Clicking in this field invokes the standard Open dialog, from which a text
file may be selected.

For text files, the file is simply placed, in its entirety, as is. Text files must be preformatted and designed
using any text editor before they are imported to WorldChart.

Right Inset: the distance from the right edge of the frame at which the text is inset. Clicking in this field
activates a slider bar and input field above, from which the desired border size (from 1 to 20) may be
entered. These values represent a percentage of the HTML page width. Invalid input will not be ac-
cepted.

Left Inset: the distance from the left edge of the frame at which the text is inset. Clicking in this field
activates a slider bar and input field above, from which the desired border size (from 1 to 20) may be
entered. These values represent a percentage of the HTML page width. Invalid input will not be ac-
cepted.

Font Color: the color for the imported text. Clicking in this field invokes the standard Windows Color
dialog, from which the desired color may be selected.

HTML Report Editor

The HTML Report Object Properties list window may be
invoked by double clicking on the placed report, selecting
Show Properties for HTML from the right mouse menu, or
HTML/Text Properties from the View menu.

HTML objects may not be altered in WorldChart: they are
simply placed as is, and retain all preset properties. The
Object Properties list window for HTML Reports may be
used only to select the HTML file itself.

Object Type: the selected object’s type: HTML.

Data Type: the data type for the report: HTML

Data File: the placed HTML file. Clicking in this field invokes the standard Open dialog, from which the
desired file may be selected.

For HTML files, the file is simply placed, in its entirety, as is. HTML files must be preformatted and
designed using any HTML editor before they are imported to WorldChart.
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Chart Preferences

The Chart Preferences  window con-
tains items used to define the color,
text, environment, and scaling param-
eters for the generated chart.

Scaling Type: the scaling type used
for the graph. The pull down menu lists
available types: Global, Column, and
Row. (For more information on Scal-
ing Type and its options, see Chart
Scaling.)

X Factor: the scaling factor applied to the chart along the X axis, as selected from the slider bar. Valid
input ranges from 1 to 100. (The width of a bar in a bar chart is set equal to “one” for this scale.)

Y Factor: the scaling factor applied to the chart along the Y axis, as selected from the slider bar. Valid
input ranges from 1 to 100. (The width of a bar in a bar chart is set equal to “one” for this scale.)

Z Factor:  the scaling factor applied to the chart along the Z axis, as selected from the slider bar. Valid
input ranges from 1 to 100. (The width of a bar in a bar chart is set equal to “one” for this scale.)

Cage Steps: the number of horizontal lines to be shown on the enclosing walls of the generated chart, as
selected from the slider bar or entered in the input field. Valid input ranges from 3 to 10.

Decimal Precision: the decimal point position to which numeric input will be entered from the data file
for the generated chart. (For example, 1.07 has a decimal precision of 2, and .007 has a decimal preci-
sion of 3.) Decimal Precision may be set from 0 to 5 using the slider bar or the input field.

Start Color: the start color, located at the first entry or lowest point in the chart, used for the graph color
gradient. Clicking on the browse button invokes the standard Windows Color dialog, from which the
desired color may be selected.

End Color: the end color, located at the last entry or highest point in the chart, used for the graph color
gradient. Clicking on the browse button invokes the standard Windows Color dialog, from which the
desired color may be selected.

Select Popup Font: font parameters for popup text. Clicking on the button invokes the Font dialog from
which the font, style, and size may be selected, and a sample previewed.

General Preferences Editor

The General Preferences  editor provides a tabbed interface from which general properties may be set.
This editor may be invoked by selecting the Preferences… item from the View Menu.

This editor is used to control two aspects of the WorldChart working environment:
• to define the default properties used when a new document, chart, or report is generated, and
• to define the GenPrefs style.

Default preferences defined by this editor will be applied to each new document, chart, and report. They
will not override properties set for documents previously saved and reopened. Options set in this editor
are immediately saved when the Apply or Close button is selected, and will be used for the next new
object.

Properties set in this editor are default properties. They may be changed for individual documents and
objects using the Document, Chart, or Report Properties editors, and will not override any properties set
individually using these editors.

These preferences are also written to the style GenPrefs. The styles include all text, color, and back-
ground images, as defined in the General Preferences editor.

Selecting the GenPrefs style from the Styles pulldown menu in the Document Properties editor will
assign these properties to the selected document. The font and color properties defined by the style will
be applied to the document, then the Styles menu will immediately revert to the style <None> to indicate
that properties may be set individually using the Document, Chart, and Report Properties editors.

• The Chart Preferences  window contains items used to define the color, text, animation, and
scaling parameters for the generated chart.

• The Chart File Defaults  window contains items used to define applied images, sounds, and view-
ing parameters for the generated chart.

• The Report Preferences  window contains items used to define the font and table style param-
eters to be applied to the generated report.

• The Publishing Preferences  window contains items used to determine how the document will be
published when Publish is selected from the toolbar or File menu.
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Chart File Defaults

The Chart File Defaults  window con-
tains items used to define applied im-
ages, sounds, and viewing param-
eters for the generated chart.

Cage Right Image: the texture
mapped image applied to the right
cage wall of the generated chart. Click-
ing on the Browse button invokes the
standard Windows Open dialog, from
which the desired image file (.gif, .jpg,
or .png) may be selected. This image
is displayed in the preview window to
the right. (Images may not be applied
to the cage for Single- or MultiStock
Charts.)

Cage Left Image: the texture mapped image applied to the left cage wall of the generated chart. Clicking
on the Browse button invokes the standard Windows Open dialog, from which the desired image file (.gif,
.jpg, or .png) may be selected. This image is displayed in the preview window to the right. (Images may
not be applied to the cage for Single- or MultiStock Charts.)

Background Image: the image file used for the background of the generated chart. Clicking on the
Browse button invokes the standard Windows Open dialog, from which the desired image file (.gif, .jpg,
or .png) may be selected. This image is displayed in the preview window to the right.

Sound Source: the WAV (.wav) or MIDI (.mid) file associated with the chart. Clicking on the Browse
button invokes the standard Windows Open button, from which the desired sound file may be selected.

Sound Type: the sound type, Soundtrack or Spatial, that will be applied to the sound file in the generated
chart, as selected from the pulldown menu.

Soundtrack generates sound which is not influenced by the position or movement of the viewer.
Soundtrack sound will play only once.

Spatial generates directional sound, which is placed at the world origin (0, 0, 0), and responds to the
position and movement of the viewer. Spatial sound loops continuously.

View Distance: the distance from the chart at which the initial viewpoint will be set, as selected from the
pulldown menu. Distance may be set to Near, MidRange, or Far.

View Angle: the view angle at which the initial viewpoint will be set, as selected from the pulldown menu.
View Angle may be set to Top Down, Level, or Low.

Select HUD Font: font parameters for HUD text. Clicking on the button invokes the Font dialog from
which the font, style, and size may be selected, and a sample previewed.

Popup Text Justify: the justification for the popup text, as selected from the popup menu. Text may be
Default, Left, Right, or Center justified. The Default setting will automatically justify the text according to
its position on the chart: text on the left side will be right justified, and text on the right side will be left
justified. This option generates the best results, and should be used whenever possible.

HUD Text Justify: the justification for the HUD text, as selected from the popup menu. Text may be
Default Left, Right, or Center justified. The Default setting will automatically justify the text according to
its position on the HUD: text on the left side will be left justified, and text on the right side will be right
justified. This option generates the best results, and should be used whenever possible.

Popup and HUD Text Color: the color used for the Popup/HUD text. Clicking on the browse button
invokes the standard Windows Color dialog, from which the desired color may be selected.

Grid Color: the color used for the grid on the floor and walls of the generated chart. Clicking on the
browse button invokes the standard Windows Color dialog, from which the desired color may be se-
lected.

Floor Color: the color used for the floor in the generated chart. Clicking on the browse button invokes
the standard Windows Color dialog, from which the desired color may be selected.
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Publishing Preferences

The Publishing Preferences  window
contains items used to determine the
default publishing parameters that will
be used when Publish is selected from
the toolbar or File menu. Publishing
parameters for documents may be set
individually using the Document Prop-
erties editor’s Publish Properties
tabbed window.

Documents may be published either
to a FrontPage web, or to a directory,
or to both simultaneously.

The Publish property settings are maintained throughout the project, and will be applied each time the
project or document is saved or published.

Publish to FrontPage web?: selecting this check box will publish the document to the selected FrontPage
web when the Publish command is executed.

Front Page Webs: the webs available on the selected FrontPage server.

Enter a server: the URL of the selected FrontPage web. Clicking on the Refresh button will allow you to
browse through the available webs.

Publish to file?: selecting this check box will publish the document to the selected directory when the
Publish command is executed.

Publishing directory: standard Windows format pull down menus from which the desired drive and
folder may be selected.

Default publish location directory: displays the selected folder’s directory path. This folder will be the
default publish location for all documents published to file.

Report Preferences

The Report Preferences  window con-
tains items used to define the font and
table style parameters to be applied
to the generated report.

Heading Font Style: the style of the
heading font, as selected from the pull
down menu. Available styles include
Default, Bold, Italic, and BoldItalic.
(The Report Heading is made up of
the column names, and is located at
the top of the report.)

Field Font Style: the style of text in the report’s fields, as selected from the pull down menu. Available
types include Default, Bold, Italic, and BoldItalic.

Heading and Field Font Type: the type of font used for the heading and fields, as selected from the pull
down menu. Available font types include Plain, Serif, Sans and Typewriter.

Heading Color: the color of the heading’s background, as selected from the standard Windows Color
dialog, invoked by clicking on the browse button.

Field Color: the color used for the report’s fields’ background, as selected from the standard Windows
Color dialog, invoked by clicking on the browse button.

Heading and Field Font Color: the color of the Heading and fields’ text, as selected from the standard
Windows Color dialog, invoked by clicking on the browse button.

Heading Font Size: the size of the font used for the heading (4-8), as selected from the slider bar or
entered in the input field. Invalid input will not be accepted.

Field Font Size: the size of the text (1-4) used in the fields, as selected from the slider bar or entered in
the input field. Invalid input will not be accepted.

Table Border Size: the size of the borders used for the report table (0-6), as selected from the slider bar
or entered in the input field. Invalid input will not be accepted.

Background Color: the color used for the background of Text reports. Clicking on the browse button will
invoke the standard Windows color dialog, from which the desired color may be selected.

Chapter 4   WorldChart Program Overview



6968 WorldChart Users Guide

5. Assign behaviors for defined elements:  used to assign animations to chart values. This page acts
as a sentence definition of animations to be applied for given numeric values in the chart. It is
organized to read: For each “column name” in “file name” where the value is greater than (>), less
than (<), equal to (=), greater than or equal to (>=), less than or equal to (<=), or not equal to (<>) the
entered number, assign “spinning,” “pulsing,” or “flashing” for the object’s behavior.

You fill in the blanks. Using the pulldown menu, select a table from the file listed to the right. Then, select
less than, equal to, or greater than from the pulldown menu below, and type a number in the field to its
right to define which values in the generated chart will be affected. Finally, select an animation from the
pulldown menu to the right, which includes spinning, pulsing, and flashing.

6. Publish Preferences:  offers the selection of publishing the completed document to a FrontPage
web, to a selected directory, or to both.

7. Synopsis:  presents a synopsis of the generated document’s features, and a check box which, when
selected, will cause the document to be opened in preview mode.

4.7 Document Wizard

WorldChart offers a Document Wizard to assist users in the generation of documents. This wizard is
designed to simplify and codify the design process for the user. Any selections or decisions made while
using the wizard may, of course, be altered when the process is complete.

The Document Wizard walks the user through the creation of a document, allowing them to select the
document, insert chart and report types and data files, and to arrange imported information for the se-
lected charts and reports.

Upon completion of the process, the Document Wizard updates the Project View Window, generates the
Document, makes it active, and places it on top of the stack in the Project Window.

1. Select Template Type:  allows you to select a document type. Clicking on one of the icons in the
window will place a document of that type in the project window. Available document types include
One Frame, Two Frame, Three Frame, and Three Frame Inverted.

This window also includes a Styles pull down menu, from which a style may be selected to define the
color scheme and font style for the generated document.

2. Select an item for each frame:  allows you to select the document’s reports and charts. Clicking on
one of the icons in the window will place an object of that type in the designated frame of the docu-
ment. Frames for the document are presented in order, from left to right and top to bottom. Available
Object types include all charts and reports, except for the HTML and Text Reports.

3. Select a data source for all items in document:  presents a browse window from which the desired
data source may be selected. Only one source file may be selected using the Document Wizard,
which will be used for all objects in the documents. Individual document source files may be selected
upon completion of the Wizard, using the Chart or Report Properties editors.

4. Select a table and arrange the columns:  allows you to select the table and column order for the
imported data. Only one file will be applied to all items in the generated document

Select a table:  a pull down menu with which the desired table from a multi-table file may be
selected.

Selected Column, Database Schema:  allows you to select and arrange the columns from the
table to be used in the generated document, using the Move Up, Move Down, Add, and Remove
buttons
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5.1 Formatting Files for Import

WorldChart generates charts and graphs using information imported in tabular format.

Tables are arranged in rows and columns. Rows run horizontally; columns run vertically. Each cell in
the table, each blank space for input, is called a field .

For Example:

First Name Last Name Age Salary

John Doe 34 30,000

Henry Foobar 45 12,000

Robert Lando 27 56,000

This table has four columns : First Name, Last Name, Age, and Salary; and four rows: John Doe, Henry
Foobar, and Robert Lando, and the first row, which is saved for column names.

Each column in a table must have a name, and each field of each column must have an entry. WorldChart
will automatically enter “0” (zero) in any blank field of an imported file. (Each row should also be named.)

For the best and most predictable results, data that will be imported to WorldChart should be properly
formatted. To properly format files, a few simple rules should be followed:

• All field values must be defined
• All data must be formatted in rows and columns
• All columns must be named
• Each column must contain only one data type
• Each set of data must be entered on a separate table

For information on specific file formats, see the chapters listed below:

• Excel Files
• Access Files
• Text Files (Comma Delimited Files)

Chapter 5   Importing Data Files

All objects (charts, reports, HTML, and text files created in a WorldChart document) require an imported
data source file. WorldChart supports the generation of both HTML reports and VRML charts by using
industry standard data file formats, commonly found on most business desktops.

For its chart and report generation, WorldChart requires that the imported data be in tabular format,
saved in one of the following file formats:

• Microsoft Excel 97 (or earlier) .xls
• Microsoft Access 97 (or earlier) .mdb
• Comma Delimited Text Files .csv

For best and most predictable results, the tables imported in these file formats should be formatted using
certain conventions.

For more information on formatting, importing, and working with spreadsheet information, see the appro-
priate sections, as listed below.

• Formatting Files for Import
• Fields
• Rows
• Columns
• Tables
• Tables for MultiStock Reports

More specific information on individual file types is also included.

• Access Files
• Comma Delimited Files
• Excel Files
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Columns

Tables are arranged in rows and columns. Rows run horizontally; columns run vertically. Each cell
in the table, each blank space for input, is called a field .

When a table or spreadsheet is imported, WorldChart reads the first row of the table (the top field of
each column) as Column Names . For this reason, tables should be designed such that the first row
contains only column names, and data entry begins in the second row of the table.

If a table is imported which has the first field of any given column empty, WorldChart assigns the
column a name, based on its position in the table. The name is generated as Fnumber, with the
number being equal to the column’s order in the table. If “Salary” were not labeled in the example
above, that column would be labeled F4.

Empty fields in a column below the column name will be displayed in a generated report as a blank
field, and in a chart as 0.0.

If an empty column is imported for a chart, it will be ignored and skipped. If an empty column is
imported for a report, the column name will be set to Fnumber, and all fields below the column name
will displayed blank.

If a column is imported which has some numeric fields, and some text fields following the first field
(the column name, which may be text), the column will be read as text.

Fields

Fields are the cells of a table. They contain the information or data that will be used in the generation
of a WorldChart chart or report.

Each field in an imported file must have a value entered. If files with empty fields are imported, “0.0”
will be entered in the blank fields, whether they are text or numeric fields.

Fields may contain either text or numeric entries. Any mix of these two within the same field will be
treated as text.

If an empty field is imported, it will be read as a value of 0.0. Data entered for a chart will be shown as
a 0.0 value; data entered for a report will be displayed as an empty field.

A data type  is the kind of information which is entered in each field in the imported file. All data types
are converted to either numbers or text, depending on what is found in the cell.

WorldChart will import all data types from Excel and Access. Their translation may be unexpected.
Please note how the different data types will be imported to both Access and Excel files.

Rows

Tables are arranged in rows and columns. Rows run horizontally; columns run vertically. Each cell
in the table, each blank space for input, is called a field .

Rows must contain information which is all related to the item named in the first column of the row.
The type of information, numeric or text, contained within a row may vary from field to field, but
should all be related to the item named in the first column of the row. The first row of any table must
contain only the columns’ names.

Rows represent records in a database or series in a spreadsheet. The first field in the row is called
the row heading, and identifies the record or series.

If an empty row is imported, it will be shown as a series of 0.0 values for a chart, and as a continuous
line across the width of a report.
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Multi-Table Files

The arrangement of data in Multi-Table reports and charts should be consistent from table to table,
throughout a file. If this information differs, the charts and reports produced from them will differ as
well, and will generate an inconsistent final presentation.

Tables should be designed such that each column in the first table corresponds to the same column
in the others, in both name and data type. If this is the case, the information will be properly trans-
lated into WorldChart, and the charts and reports generated from it will be consistent and logical.

Individual tables may be selected from multi-table files for import.

Excel’s named range format may also be imported as an individual table. It is important to note that
both the table, and all named ranges within it will appear in the select a table pulldown menu in the
data import windows of the properties editors.

See Also: Importing Data Files, Publishing Files.

Tables for MultiStock Reports

For the MultiStock Report format, WorldChart supports the import of a multi-table file. The specific
format for these files varies from program to program, but the general principles are standardized.

When importing multi-table files for MultiStock Reports, the layout of the tables must be consistent.
That is, the rows and columns must be identically named and formatted from table to table.

Tables

Each imported file may contain multiple tables.

Using an empty row to separate two data sets may cause unexpected results, in that WorldChart will
only accept the first field of each column as the column name. The column name may not apply to all
data within the column, and the data format may change from one field to the next (numbers to text,
or vice-versa).

Empty rows in imported tables will be read as a series of 0.0 values. Data entered for a chart will be
shown as 0.0 values; data entered for a report will be displayed as empty fields.

First Name Last Name Age Salary

John Doe 34 30,000

Henry Foobar 45 12,000

Stock Price1 Price2 Price3

TRBS 23.375 26.75 30.25

LCS 12.5 11.375 10.5

The exceptions to this rule are Excel’s Named Ranges, and file formats which provide a means for
including multiple tables, on separate pages, within a single file, such as the Excel Workbook and
Access Database.

For example:

As these columns contain
both text and numeric fields,
the table shown above will
generate errors when the
chart or report is previewed.
For import into WorldChart,
this table should be split into
two tables, each contained
within a separate file, as
shown below.

First Name Last Name Age Salary

John Doe 34 30,000

Henry Foobar 45 12,000

Stock Price1 Price2 Price3

TRBS 23.375 26.75 30.25

LCS 12.5 11.375 10.5

Page1: Clients

Page2: Doe Portfolio
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5.2 Access Files

WorldChart supports Microsoft Access files as a data source for document reports and charts.

To import Excel files, WorldChart uses the MS Jet Database driver, which is installed when either MS
Excel or MS Access is installed with the DAO Objects options selected. This driver must be available for
these files to be imported.

Access creates tables in rows and columns. Columns correspond to the fields of a record, and rows
represent entire Access records.

Formatting Access Files

When formatting Access database files, it is important to define the data type when setting up the file. For
best results, the data type selected should be “Text” for all text based columns, and “Number” for all
numerically based columns. Selecting any of the other options in Access may result in unpredictable
behavior.

It is also important to note that Access’ “Field Names” corresponds to WorldChart “Column Headings.”
The Field Name defined in each file will appear in the WorldChart report or chart as the title for that
column’s information. The first row of each table in an Access file will be entered data, and not the
Column Name, as with Excel or Comma Delimited files. WorldChart will use the field names to recon-
struct the column headings.

A data type  is the kind of information which is entered in each field in the imported file. All data types are
converted to either numbers or text, depending on what is found in the cell.

WorldChart will import all data types from Access. Their translation may be unexpected. Please note
how the different data types will be imported.

Text, date and time, and yes and no buttons are converted to text. Numbers and currency are converted
to numbers. The Memo data type is not supported.

Creating Access Database (.mdb) Files

WorldChart supports Microsoft Access files as a data source for document reports and charts.

Multiple tables related to the same project should be contained in a single database.

WorldChart uses a table for each report or chart, as selected from the available tables in a database.
Only tables from within a single database may be used to generate a MultiStock Chart or Report.

Tables for Single- and MultiStock Charts

For the SingleStock and MultiStock Chart formats, WorldChart supports the import of a multi-table file.
The specific format for these files varies from program to program, but the general principles are stan-
dardized.

For multi-table files, the layout of the tables must be consistent. That is, the rows and columns must be
identically named and formatted from table to table.

The MultiStock and SingleStock chart types expect the following column headings:
• Date
• High
• Low
• Close
• Volume

It is not necessary for these headings to be in this order, but it is necessary for the headings to be named
in this manner. (Case sensitivity does not apply.) Any columns which do not have these headings will not
be imported.

MultiStock charts will read the first table, then limit the number of imported rows in each subsequent
table to the number in the first. MultiStock charts will also disregard the High and Low columns, as they
are not included in the generated chart. (Only the Volume and Close Price are shown.) These items will,
however, appear in the data window of the Chart Properties editor.

For more information on formatting multiple tables in Excel and Access, see Excel Files and Access
Files below.
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5.4 Excel Files

WorldChart supports Microsoft Excel files as a data source for document reports and charts.

To import Excel files, WorldChart uses the MS Jet Database driver, which is installed when either MS
Excel or MS Access is installed with the DAO Objects options selected. This driver must be available for
these files to be imported.

Excel formats spreadsheets in rows and columns, and calls each spreadsheet a Worksheet. A group of
related Worksheets contained within one Excel file is called a Workbook . An area of a worksheet may
be uniquely identified as a Named Range. WorldChart will import named ranges as tables within the file.

A WorldChart MultiStock Chart or Report may be created from a group of Excel spreadsheets only if all
spreadsheets to be used are contained within a single Excel file, as part of a single Workbook, and if the
consistency of the rows and columns in all spreadsheets is maintained.

Excel Workbooks and their Worksheets must be carefully formatted for use in WorldChart.

Formatting Excel Worksheets

Each Worksheet should contain only one complete set of data (unless you are using named ranges).
Using an empty row to separate two data sets may cause unexpected results. The column name may not
apply to all data within the column, and the data format may change from one field to the next (numbers
to text, or vice-versa). To avoid this problem, use named ranges to separate tables.

WorldChart imports named ranges as a separate table, and they will appear in the Tables pulldown menu
of the Data window in the properties editing dialogs. Note that the table in which the named ranges are
contained will also appear in the same pulldown menu list, and be certain to make the intended selection.

A data type  is the kind of information which is entered in each field in the imported file. All data types are
converted to either numbers or text, depending on what is found in the cell.

WorldChart will import all data types from Excel. Their translation may be unexpected. Please note how
the different data types will be imported.

Currency values, accounting values, percentage values, fractions, scientifics, specials, and customs are
converted to numbers. Dates and times are converted to text.

Multiple Worksheets related to the same project should be contained in a single Workbook.

5.3 Comma Delimited Files

WorldChart supports Comma Delimited files as a data source for document reports and charts.

Comma Delimited files (.csv files) are text files which contain tabular information in a comma separated
format. In these files, rows are strings of text, separated by hard returns, and columns are items within
these strings, separated by commas.

Note that spaces between commas will be maintained in the final report, and that commas that are to be
included within a field entry must be enclosed in double quotes.

For example, the table shown under Formatting Files for Import is shown here as a Comma Delimited
file:

First Name,Last Name,Age,Salary
John,Doe,34,”30,000"
Henry,Foobar,45,”12,000"
Robert,Lando,27,”56,000"

Note that there are no extra spaces between entries, and that the commas to be included in the salaries
are enclosed with quotes.

Note: As .csv files may not be generated as multiple tables within a single file, they may not be used for
MultiStock Reports or Charts.
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Chapter 6  Working With Imported Data

WorldChart automatically translates your input files using preset and user definable systems of transla-
tion. WorldChart will read each Column Heading as a title for that column of information, and the first
entry of each row as a title for that row of information.

The interpretation of data, and the generation of charts may be controlled using Data Mapping, and Chart
Scaling, as described in the sections that follow.

6.1 Data Mapping

WorldChart allows you to select and arrange the order of columns after a file has been imported. The
Data tabbed window in the Chart and Report Properties editors lists all available columns in the imported
file. From this list, individual columns may be selected by name, marked for inclusion in or exclusion from
the generated chart or report, and moved up or down in the list to position them in the final chart or report.

This allows you to fine tune the sequence and appearance of WorldChart documents, as well as correct
any formatting errors that may have occurred in the imported files themselves.

Rows may not be individually selected, nor may their order be rearranged.

It is important to note that MultiStock and SingleStock Charts have special restrictions placed upon the
format of their imported data files. (see Tables for Single- and MultiStock Charts for more information.)

These chart types also have certain restrictions placed on their use of the Data tabbed window. Only
those columns which are named Open, Close, High, Low, or Volume will appear in the list of available
columns. Other Column Names will not be imported, and the data contained in their fields will be skipped.

The Data tabbed window may be used to select which of these fields will be imported for the generated
chart, but rearranging their order will have no effect on the generated chart. WorldChart maps these
columns to specific aspects of the generated chart, which may not be altered by the user. Volume is used
to generate the upper portion of the chart. Close is used for the lower, line chart portion of the chart. The
MultiStock chart displays the High and Low values in the HUD. The SingleStock chart plots these values
as part of the line chart.

Creating Excel Workbooks

In Excel, a Workbook is a tabbed collection of spreadsheets, contained within a single file. Each spread-
sheet in this collection is called a Worksheet . Areas of worksheets may be uniquely identified as named
ranges.

WorldChart uses a Worksheet for each report or chart, as selected from the available Worksheets in a
Workbook. Only Worksheets from within a single Workbook may be used to generate a MultiStock Chart
or Report.

For this reason, a Workbook must be designed to communicate the desired information clearly and
consistently. For instance, if a user wants to produce a report consisting of three documents on invest-
ment performance, all Worksheets necessary for the report must be placed in one Workbook.

Workbook: PORTFOLIO.XLS

Worksheet Columns
Joe’s Pants Date, High, Low, Close, Volume
Mom’s Diner Date, High, Low, Close, Volume
Pat’s Salon Date, High, Low, Close, Volume

In this example, each Worksheet in the Workbook will follow a single stock over a period of time. The
Workbook as a whole will compare the performance of the various stocks in the portfolio.

Note: Only MultiStock Charts and Reports require more than one table, and, therefore, a Workbook
containing Worksheets. All other chart and report types require only a single table, and may be gener-
ated both from a table selected from within an Excel Workbook, or from a simple, single table file.

Chapter 6  Working With Imported Data
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Selecting Column is similar to selecting row, except that it compares information across columns, rather
than across rows. Scaling by Column sets the lowest values in each column to zero, and the highest
value in each to one, then scales all remaining values in each column between the two.

For example, 5 bottles, 40 cans, 10 pounds of paper, and 0 plastic bottles will be equal and placed at the
lowest point on the graph, and 300 bottles, 900 cans, 20 pounds of paper, and 60 plastic bottles will all be
equal and placed at the highest point on the graph.

If Scaling by Column is selected, cage labels in the generated chart will be omitted.

The most useful scaling type to select will depend upon the way in which the original input file is de-
signed, and the type of information that is to be demonstrated from it.

6.2 Chart Scaling

Chart Scaling is a means of controlling the translation of information into a chart, which enables you to
more easily compare information in any given chart.

There are three types of Chart Scaling: Global , Row , and Column . These options may be set through
the Chart Properties editor, or the General Preferences editor’s Chart Preferences tab window. Global
scaling is the default mode.

Selecting Global applies global scaling to the chart. For this option, WorldChart reads all numeric values
in all fields in the chart, and determines which are the highest and lowest values entered. It then sets the
lowest to be the lowest point in the chart, and the highest to be the highest, and scales all other values
proportionally between the two.

Student Bottles Cans Paper

Nicki 5 60 15

Chris 45 900 10

Pat 300 40 20

For example, in the input file shown above, the lowest value is 0, and the highest is 900. WorldChart will
automatically set 0 equal to zero, and 900 equal to one unit in the generated chart. It will then scale the
remaining values proportionally between these two. 0 will be the lowest point on the generated chart, 900
will be the highest, 60 will be 1/15th of the distance between them, 300 will be 1/3rd the distance between
them, 45 will be 1/20th the distance, and so on.

Selecting Row scales the chart by rows. WorldChart will examine each row in the file, and set the lowest
value in each to the lowest point on the chart, the highest to the highest, and scale the remaining values
in each row proportionally between these two points.

For example, in the file shown above, Nicki ranges from 5 to 60, and Pat ranges from 20 to 300. WorldChart
will set the 5 and the 20 to be equal, and the 60 and the 300 to be equal. It will then scale the remaining
numbers in each row proportionally between the two, such that a value of 30 in row A will equal a value
of 180 in row C.

Scaling a chart by row is useful in that it allows you to make comparisons between sets of information at
a glance, by comparing overall changes between individual highs and lows for any given set of data.

If Scaling by Row is selected, cage labels in the generated chart will be omitted.

Chapter 6  Working With Imported Data
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To publish to a directory:
• Select the “Publish to selected directory” checkbox.
• Select the directory to publish to: type in a path name, or use the Browse button to select the

desired folder.
• Select or define a file name for the Document (this will be an HTML file).

To publish to an MS FrontPage web:
• Select the “Publish to selected FrontPage web” checkbox.
• Type the web address of the FrontPage server in the server box.
• Use the Refresh button to select an available web.
• Select the FrontPage web to publish to from the list of available FrontPage webs.

Click on OK to save the publishing preferences. When Publish is selected from the File menu, the
document will be published to the selected directory and/or web site.
Projects are a means to organize your working documents. Projects serve as a container for saved
documents, and opening a Project will open all documents saved to it.

Chapter 7  Publishing Files

WorldChart files may be published to a directory, to a FrontPage web, or to both simultaneously.

Publishing to a directory saves the files, in .htm and .wrl format, to the selected folder on your machine.

WorldChart generates and saves a separate file for each document, chart, report, text file, and HTML file
contained in any WorldChart document. It does not encapsulate chart or report files within the document
file in which they are placed. The document file saves the document’s information, title, color scheme,
location, etc., and points to the files which contain information for the charts and graphs contained within
it. The included charts and graphs are each saved as individual files.

WorldChart automatically generates a name for each file generated. These names follow the format:
object type_number.filetype, where the object type is document, one_frame, analysis, etc. the number is
a three digit number randomly generated by WorldChart, and the filetype is “htm” for documents, text,
and HTML files, and “wrl” for all report and chart files. (Note: If file names are changed, the file may not
be found, and the link may be broken.)

Publishing to a FrontPage web publishes the document to any FrontPage web available from your com-
puter.

Publishing options, including whether to publish to a directory, to a FrontPage web, or to both, are located
in the Publishing Properties tab of the Document Properties editor. When these options have been set,
they are maintained and followed each time Publish is selected from the File menu, or the Publish button
is pressed from the tool bar. These options may be changed at any time.

The filename set in the Document Properties window will be entered automatically in this dialog. You may
change the file name, or save it elsewhere or under a different name from this dialog. You may also
change the names of and resave all objects contained within the selected document (all reports, charts,
text and HTML files placed in the document’s frames).

Chapter 7  Publishing Files
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